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This help file describes the NI Vision Acquisition Express VI, and
describes the fundamentals of configuring your acquisition settings using
an analog, parallel digital, camera link, IEEE 1394 or Gigabit Ethernet
(GigE) camera. The NI Vision Acquisition Express VI also supports
simulated acquisitions from a folder of images.
Note Acquisitions using an IEEE 1394 or GigE camera require
you to activate the NI Vision Acquisition Software. Refer to
Activating Your Software for more information.
For more information about this help file, refer to the following topics:
Using Help
Related Documentation
Glossary
Important Information
Technical Support and Professional Services
To comment on National Instruments documentation, refer to the National
Instruments Web site.
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Activating Your Software
How do I activate my software?
Use the NI Activation Wizard to obtain an activation code for your
software. You can launch the NI Activation Wizard two ways:
Launch the product and choose to activate your software from the
list of options presented.
Launch NI License Manager by selecting Start»All
Programs»National Instruments»NI License Manager. Click the
Activate button in the toolbar.
Note If your software is a part of a Volume License Agreement
(VLA), contact your VLA administrator for installation and activation
instructions.
What is activation?
Activation is the process of obtaining an activation code to enable your
software to run on your computer. An activation code is an alphanumeric
string that verifies the software, version, and computer ID to enable
features on your computer. Activation codes are unique and are valid on
only one computer.
What is the NI Activation Wizard?
The NI Activation Wizard is a part of NI License Manager that steps you
through the process of enabling software to run on your machine.
What information do I need to activate?
You need your product serial number, user name, and organization. The
NI Activation Wizard determines the rest of the information. Certain
activation methods may require additional information for delivery. This
information is used only to activate your product. Complete disclosure of
National Instruments licensing privacy policy is available at
ni.com/activate/privacy. If you optionally choose to register your software,
your information is protected under the National Instruments privacy
policy, available at ni.com/privacy.
How do I find my product serial number?
Your serial number uniquely identifies your purchase of NI software. You
can find your serial number on the Certificate of Ownership included in

your software kit. If your software kit does not include a Certificate of
Ownership, you can find your serial number on the product packing slip
or on the shipping label.
If you have installed a previous version using your serial number, you can
find the serial number by selecting the Help»About menu item within the
application or by selecting your product within NI License Manager
(Start»All Programs»National Instruments»NI License Manager). You
can also contact your local National Instruments branch.
What is a Computer ID?
The computer ID contains unique information about your computer.
National Instruments requires this information to enable your software.
You can find your computer ID through the NI Activation Wizard or by
using NI License Manager, as follows:
1. Launch NI License Manager by selecting Start»All
Programs»National Instruments»NI License Manager.
2. Click the Display Computer Information button in the toolbar.
For more information about product activation and licensing refer to
ni.com/activate.

Related Documentation
Most NI Vision Acquisition Software manuals also are available as PDFs.
You must have Adobe Reader with Search and Accessibility 5.0.5 or later
installed to view the PDFs. Refer to the Adobe Systems Incorporated
Web site at www.adobe.com to download Adobe Reader. Refer to the
National Instruments Product Manuals Library at ni.com/manuals for
updated documentation resources.
The following documents contain information that you may find helpful as
you use this help file:
NI Vision Acquisition Software Release Notes—Contains
information about new functionality, minimum system
requirements, and installation instructions for NI-IMAQ, NIIMAQdx, and NI-IMAQ I/O driver software.
Measurement & Automation Explorer Help for NI-IMAQ—
Describes how to configure NI-IMAQ driver software, NI image
acquisition devices, and cameras using Measurement &
Automation Explorer.
Measurement & Automation Explorer Help for NI-IMAQdx—
Describes how to configure NI-IMAQdx driver software, IEEE 1394
cameras, and GigE cameras using Measurement & Automation
Explorer.

Using Help
Conventions
Navigating Help
Searching Help
Printing Help File Topics

Conventions
This help file uses the following formatting and typographical
conventions:
»

The » symbol leads you through nested menu items and
dialog box options to a final action. The sequence File»Page
Setup»Options directs you to pull down the File menu,
select the Page Setup item, and select Options from the last
dialog box.
This icon denotes a note, which alerts you to important
information.

bold

Bold text denotes items that you must select or click in the
software, such as menu items and dialog box options. Bold
text also denotes parameter names.

green

Underlined text in this color denotes a link to a help topic,
help file, or Web address.

italic

Italic text denotes variables, emphasis, cross-references, or
an introduction to a key concept. Italic text also denotes text
that is a placeholder for a word or value that you must
supply.

monospace Text in this font denotes text or characters that you should
enter from the keyboard, sections of code, programming
examples, and syntax examples. This font is also used for
the proper names of disk drives, paths, directories,
programs, subprograms, subroutines, device names,
functions, operations, variables, filenames, and extensions.

Navigating Help (Windows Only)
To navigate this help file, use the Contents, Index, and Search tabs to
the left of this window or use the following toolbar buttons located above
the tabs:
Hide—Hides the navigation pane from view.
Locate—Locates the currently displayed topic in the Contents tab,
allowing you to view related topics.
Back—Displays the previously viewed topic.
Forward—Displays the topic you viewed before clicking the Back
button.
Options—Displays a list of commands and viewing options for the
help file.

Searching Help (Windows Only)
Use the Search tab to the left of this window to locate content in this help
file. If you want to search for words in a certain order, such as "related
documentation," add quotation marks around the search words as shown
in the example. Searching for terms on the Search tab allows you to
quickly locate specific information and information in topics that are not
included on the Contents tab.

Wildcards
You also can search using asterisk (*) or question mark (?) wildcards.
Use the asterisk wildcard to return topics that contain a certain string. For
example, a search for "prog*" lists topics that contain the words
"program," "programmatically," "progress," and so on.
Use the question mark wildcard as a substitute for a single character in a
search term. For example, "?ext" lists topics that contain the words
"next," "text," and so on.
Note Wildcard searching will not work on Simplified Chinese,
Traditional Chinese, Japanese, and Korean systems.

Nested Expressions
Use nested expressions to combine searches to further refine a search.
You can use Boolean expressions and wildcards in a nested expression.
For example, "example AND (program OR VI)" lists topics that contain
"example program" or "example VI." You cannot nest expressions more
than five levels.

Boolean Expressions
Click the button to add Boolean expressions to a search. The following
Boolean operators are available:
AND (default)—Returns topics that contain both search terms. You
do not need to specify this operator unless you are using nested
expressions.
OR—Returns topics that contain either the first or second term.
NOT—Returns topics that contain the first term without the second
term.
NEAR—Returns topics that contain both terms within eight words
of each other.

Search Options
Use the following checkboxes on the Search tab to customize a search:
Search previous results—Narrows the results from a search that
returned too many topics. You must remove the checkmark from
this checkbox to search all topics.
Match similar words—Broadens a search to return topics that
contain words similar to the search terms. For example, a search
for "program" lists topics that include the words "programs,"
"programming," and so on.
Search titles only—Searches only in the titles of topics.

Printing Help File Topics (Windows Only)
Complete the following steps to print an entire book from the Contents
tab:
1. Right-click the book.
2. Select Print from the shortcut menu to display the Print Topics
dialog box.
3. Select the Print the selected heading and all subtopics option.
Note Select Print the selected topic if you want to print
the single topic you have selected in the Contents tab.
4. Click the OK button.

Printing PDF Documents
This help file may contain links to PDF documents. To print PDF
documents, click the print button located on the Adobe Acrobat Viewer
toolbar.

NI Vision Acquisition Express VI Overview
Complete the following steps to launch the Vision Acquisition Express VI:
Launch the NI Vision Acquisition Express VI through LabVIEW by
creating a block diagram, opening the Functions palette, and selecting
the Vision Acquisition Express VI from the Vision and Motion menu.
Place the NI Vision Acquisition Express VI on the block diagram. This will
launch the NI Vision Acquisition Wizard. After you have configured the
acquisition, you can double-click the NI Vision Acquisition Express VI to
edit the acquisition.

Sections
The NI Vision Acquisition Wizard consists of four main sections:
Selecting an Acquisition Source
Selecting an Acquisition Type
Configuring your Acquisition Settings
Selecting Controls and Indicators

Selecting an Acquisition Source
Use the Select Acquisition Source step to select the device to use for an
acquisition. Based on the type of device you choose to work with at this
step, the settings and options available during the Configure Acquisition
Settings step will vary. Complete the following steps to choose a device
to use for an acquisition:
1. Select a device from the list of available devices in the
Acquisition Sources control.
2. Click the

Acquire Single Image button to acquire a single

image, or click the

Acquire Continuous Images button to

acquire images from the selected acquisition device. Use the
Zoom to Fit,
Zoom 1:1,
Zoom In, and
Zoom Out
controls to adjust the zoom on the acquired image.
3. Click Next.

Acquiring from a Remote Target
The NI Vision Acquisition Express Wizard allows you to acquire images
from remote devices. Complete the following steps to configure an
acquisition on a remote target.
1. Launch LabVIEW and create a new project.
Note To add a remote target to the project, you must have
the LabVIEW Real-Time Module installed on your
computer.
2. Add a remote target to project. Refer to the LabVIEW Help for
information about adding RT targets to a LabVIEW project.
3. Right-click the target. Select New»VI. This will open a new VI and
add it under the remote target to the project.
4. Right-click the block diagram of the new VI to display the
Functions Palette. Select Vision and Motion»Vision
Express»Vision Acquisition Express VI and drag it to the block
diagram.
5. This will launch the NI Vision Acquisition Express Wizard.
6. All the devices connected to the remote target will appear in the
list of devices in the Acquisition Sources control on the NI
Vision Acquisition Express Wizard.
7. Select your device from the list of available devices in the
Acquisition Sources control.
8. Click Next.

Selecting an Acquisition Type
Use the Select Acquisition Type step to select the type of the acquisition
you want to perform. Complete one of the following sets of steps to select
the acquisition type.
Single Acquisition with Processing—Acquires a single image.
Complete the following steps to configure a single acquisition with
processing:
1. Select Single Acquisition with Processing from the
available configuration options.
2. Click Next.
Continuous Acquisition with Inline Processing—Continuously
acquires images until an event stops the acquisition.
Complete the following steps to configure a continuous acquisition
with inline processing:
1. Select Continuous Acquisition with Inline Processing
from the available configuration options.
2. Select an Acquire Image Type. The following options are
available.
Acquire Most Recent Image—Use this mode to
acquire the most recent image. This mode could miss
some images, but the image returned will always be
the most recent.
Acquire Every Image—Use this mode for
applications in which acquiring every image is
necessary.
Note If the acquisition rate is faster than the
average processing rate, the Acquire Every
Image mode will not be able to keep up and
once all the image buffers are filled with
unprocessed images, the acquisition will begin
to lose images. The number of missed images
is an available output of the Express VI that
can be used to indicate when this condition
occurs. Use a Finite Acquisition with Inline
Processing acquisition if you need to acquire

every image, and the acquisition rate is faster
than the average processing rate.
3. If applicable, specify the Number of Images to Buffer.
4. Click Next.
Finite Acquisition with Inline Processing—Acquires a specified
number of images and returns each image as it is acquired. All
images are allocated on the first iteration. Processing can occur
while images are acquired without affecting acquisition speeds.
Complete the following steps to configure a finite acquisition with
inline processing:
1. Select Finite Acquisition with Inline Processing from the
available configuration options.
2. Specify the Number of Images to Acquire.
3. Click Next.
Finite Acquisition with Post Processing—This mode is the
same as Finite Acquisition with Inline Processing, except the
images are only available after they are all acquired.
Complete the following steps to configure a finite acquisition with
post processing:
1. Select Finite Acquisition with Post Processing from the
available configuration options.
2. Specify the Number of Images to Acquire.
3. Click Next.

Configuring Acquisition Settings
Use the Configure Acquisition Settings step to configure your acquisition.
The configuration settings available in this step will vary based on the
type of device you select in the Select Acquisition Source step of the
wizard. The following sections provide information on configuration
options based on the type of device you are using:
NI-IMAQ Devices
NI-IMAQdx Devices
Simulated Acquisition

Controls and Tools
Use the following tools to perform different functions on your images:
Image Display—This control allows users to view the resulting
images acquired.
Test—Configures the acquisition using the acquisition type and
acquisition settings configured.
Stop—Stops a continuous acquisition once it has started.
Image Number—Allows you to scroll through the acquired images
from a finite acquisition.
Zoom to Fit—Scales the image to fit in Image Display window.
Zoom 1:1—Displays the image without any zooming.
Zoom In—Enlarges the image.
Zoom Out—Reduces the size of the image.
Acquisition Status String—Updates information about the status
of the acquisition and the acquired image.

NI-IMAQ Devices
The NI-IMAQ driver software is used for acquiring images from Analog,
Parallel Digital, Camera Link and NI Smart Cameras. The NI-IMAQ
configuration step can contain the following sections, depending on the
features supported by the selected hardware and type of camera:
Note Not all NI-IMAQ devices support all of these settings.
Sensor Tab
Lighting Tab
Triggers Tab
Digital Outputs Tab
Encoder Tab
Bayer Tab
Note The Error Details control displays information about invalid
acquisition settings.

Sensor Tab
Note The Sensor tab is only supported by NI 17xx smart
cameras.
The Sensor tab allows you to view basic information about the NI 17xx
smart camera. Refer to NI 17xx Smart Camera User Manual for more
information on sensor options available for the NI 17xx smart camera.
The following controls are available on the Sensor tab:
Exposure Time (ms) specifies the length of time in milliseconds
that the camera exposes each image.
Gain specifies the gain for the camera.
Partial Scan specifies the options for partial scan, which is a
method of obtaining higher frame rates by reading out only a
portion of the image from the sensor. NI 17xx smart cameras
support 1/2 scan and 1/4 scan. In 1/2 scan, one half of the image
is read out from the center of the sensor and the rest of the image
is discarded to enable a faster start of the next frame. In 1/4 scan,
only one quarter of the image is read out. Using this mode
increases the Max Frame Rate of the sensor.
Binning affects the brightness and size of the acquired image by
combining pixels. This control allows you to specify the option for
binning. Binning allows the image sensor to collect more electrons
per pixel, which reduces the amount of required light and exposure
time. Binning results in higher frame rates and lower resolution.
Using this mode increases the Max Frame Rate of the sensor.
Note Partial Scan and Binning cannot be used
simultaneously.
Max Frame Rate displays the maximum rate of frames per second
for the current settings.

Lighting Tab
Note The Lighting tab is only supported by NI 17xx smart
cameras.
The Lighting tab allows you to control the lighting settings for the smart
camera. Some features may not be supported for your lighting device.
Refer to your device documentation information about the lighting
features supported by your device. Refer to Measurement & Automation
Explorer Help for NI-IMAQ for information on how to change the
parameters of the lighthead on a NI 17xx smart camera. Refer to NI 17xx
Smart Camera User Manual for more information on the NI 17xx smart
camera.
The following controls are available on the Lighting tab:
Enable Direct Drive enables the Direct Drive lighting.
Note Not all smart cameras support Direct Drive.
Mode specifies the lighting mode options. This control can be set
to Continuous or Strobed.
Desired Current Level (mA) specifies the desired current level in
milliamps.
Actual Current Level (mA) displays the actual current level in
milliamps.
5V TTL Strobe and 24V Strobe display the options for strobe
signal generation.
Polarity specifies the polarity for the selected strobe signal
generation.

Triggers Tab
Use a triggered acquisition to synchronize an image acquisition with
events external to the computer, such as receiving a pulse from a sensor
that indicates the position of an item on an assembly line. The trigger
signal must be connected to a trigger input of the image acquisition
device. The triggered acquisition settings available in this step will vary
based on the type of device you select in the Select Acquisition Source
step and the acquisition type you select in the Select Acquisition Type
step of the wizard. The Trigger Summary Table provides an overview of
all the triggers configured for this acquisition.
Complete the following steps to configure a trigger line.
1. Click the
Add Trigger button to add a trigger to the Trigger
Summary Table.
Tip Click the
Remove Trigger button to remove a
trigger from the Trigger Summary Table.
2. Select the Line to use for the trigger signal.
3. Use the Action control to specify the trigger type of the selected
Line. The following options are available:
Trigger Start of Acquisition—An acquisition begins when
the specified trigger line detects the correct polarity edge.
Trigger Every Image—Waits until the specified trigger line
detects the correct polarity edge to acquire each image.
Note The NI 17xx also supports specifying a trigger
delay. The delay units are milliseconds or, if
quadrature encoders are supported, encoder counts.
Trigger Start of Buffer List—When the assertion edge of a
trigger is received, the buffer list is acquired. The first buffer
always waits on a trigger before acquiring. This mode is
only supported for the Continuous Acquisition with Inline
Processing with the Acquire Image Type set to Acquire
Every Image.
Trigger Every Line—Waits to acquire each line from a line
scan camera until the specified number of Skip Triggers
edges have occurred. This mode only applies to line scan

cameras.
Trigger End of Acquisition—Stops the acquisition after
Number of Post Trigger Buffers has been acquired after a
correct polarity edge is detected on the specified trigger
line. Returns an array of pre-trigger images and post-trigger
images. This mode is only supported for the Continuous
Acquisition with Inline Processing with the Acquire Image
Type set to Acquire Every Image.
Note Not all hardware supports this feature.
Trigger Height of Acquisition—Uses the trigger signal
level to determine how long to acquire from a line scan
camera. While the trigger line is in the active state, each
line acquired will be added to the image height. When the
trigger line becomes inactive, the resulting image is
returned. This mode only applies to line scan cameras and
cannot be used at the same time as Trigger Every Image.
Note The maximum height allowed is determined by
the Acquisition Height specified in Measurement &
Automation Explorer (MAX).
Note Not all hardware supports this feature.
4. Select a Polarity to define the active edge of the trigger. The
following options are available:
Rising Edge
Falling Edge
5. Specify a Timeout, in milliseconds, to wait for the active edge of a
trigger to be received and the image to be captured.

Digital Outputs Tab
Use the Digital Outputs tab to configure the digital output lines to use in
an acquisition.
Complete the following steps to configure your digital output settings:
1. Click the
Add Digital Output button to add a digital output to
the Digital Outputs Summary Table.
Tip Click the
Remove Digital Output button to remove
a digital output from the Digital Outputs Summary Table.
2. Specify the Line to use for the digital output.
3. Specify an Action for the selected digital output line.
4. Complete one of the following sets of steps based on the selected
Action.
Pulse Train, Single Pulse, or Rearmed Pulse. Refer to
Pulse Types for more information on pulse types.
a. Specify a Polarity to define the state of the pulse.
b. Specify the Units to use for the Pulse Delay and
Pulse Width controls. Units can be in milliseconds
or Scaled Encoder counts.
Note Not all hardware supports scaled
encoders.
c. Specify a Pulse Delay as the desired duration of the
first phase of the signal in timebase units. If the
timebase units are Milliseconds, the Pulse Delay
must be greater than 0. If the timebase units are
scaled encoder, the minimum delay is one cycle.
d. Specify a Pulse Width as the desired duration of
the second phase of the signal in timebase units. If
the timebase units are milliseconds, the Pulse
Width must be greater than 0. If the timebase units
are scaled encoder, the minimum delay is one cycle.
e. Specify a trigger Source. A Source can be
Immediate, a hardware line, or a Status Signal.
When Immediate is selected, the pulse is driven
when the acquisition begins. When a hardware line

is selected, the pulse waits for the selected
hardware line to have the selected polarity. When
Status Signal is selected, the pulse waits for the
selected status signal to have the selected polarity.
Note If the Source is Immediate, the
Polarity and Signal settings do not apply. If
the Source is a hardware line, the Signal
setting does not apply.
f. Select the Polarity of the trigger signal. The
following options are avaialable:
Rising Edge
Falling Edge
g. If the Source is Status Signal, select a Signal for
the pulse trigger. The following Status Signals are
supported: Acquisition in Progress, Acquisition
Done, Frame Start, and Frame Done.
Note Frame Start and Frame Done are only
valid for area scan cameras.
Drive Status Signal
a. Specify a Polarity for the status signal.
b. Specify a Status Signal to output. The following
status signals are supported: Disabled, Acquisition
in Progress, Acquisition Done, Unasserted,
Asserted, Frame Start, Frame Done, Vertical
Synchronization Signal, Horizontal Synchronization
Signal, and Scaled Encoder. Frame Start, Frame
Done, and Vertical Synchronization Signal only
apply to Area scan cameras.
Note Scaled Encoder only applies to NI
devices that support scaled encoders.

Encoder Tab
The Encoder tab allows you to configure the encoder settings. Complete
the following steps to configure the encoder:
Note Not all devices support encoders.
1. Check the Use Encoder Settings option.
2. Specify a Divide Factor to determine how many encoder pulses
to skip before incrementing the Scaled Encoder count.
3. Specify Phase A Polarity to determine the polarity of phase A.
4. Specify Phase B Polarity to determine the polarity of phase B.
5. Specify Phase A and B Filter to determine if signals should be
filtered to prevent glitches from being counted as transitions.

Bayer Tab
The Bayer tab allows you to configure Bayer decoding settings. If your
camera outputs a Bayer image, you can use this tab to specify the Bayer
settings so the resulting image returned is a color image. The Bayer tab
is only available for monochrome digital area scan cameras.
Complete the following steps to perform Bayer decoding on an acquired
image:
1. Select the Perform Bayer Decoding check box. If it is checked,
the following settings will be used to convert the Bayer image
acquired to a color image.
2. Use the radio buttons to select the correct Pattern for your image.
The four possible variations of the Bayer encoding pattern are
available.
3. To select appropriate Red, Green, and Blue gains, acquire an
image of a white background, draw a rectangle around the area
that is most white, and then click Auto Balance.
4. Repeat Steps 2-3 until the image appears correctly.
Refer to the following sections for more information about various
aspects of Bayer cameras:
Bayer Encoding
Bayer Pattern
White Level

Bayer Encoding
Bayer encoding is a method you can use to produce color images with a
single imaging sensor, rather than using three individual sensors for the
red, green, and blue components of light. This technology greatly
reduces the cost of cameras. The Bayer color filter array (CFA) is a
primary color, mosaic pattern of 50% green, 25% red, and 25% blue
pixels. Green pixels comprise half of the total pixels because the human
eye receives most of its sharpness information from green light.
Light travels through the camera lens onto an image sensor that provides
one value for each sensor cell. The sensor, which is an array of tiny, lightsensitive diodes called photosites, converts light into electrical charges.
The sensor is covered by the Bayer CFA so that only one color value
reaches any given pixel. The raw output is a mosaic of red, green, and
blue pixels of different intensity. When the image is captured, the
accumulated charge for each cell is read and analog values are
converted to digital pixel values using an analog-to-digital (A/D)
converter.

Bayer Pattern
Bayer Pattern, sometimes referred to as demosaicing, replaces colors in
Bayer images. A decoding algorithm determines a value for the RGB
components for each pixel in the array by averaging the color values of
selected neighboring pixels and producing an estimate of color and
intensity. After the interpolation process is complete, the white balancing
process further enhances the image by adjusting the red and blue signals
to match the green signal in white areas of the image.

Example
Several decoding algorithms perform color decoding, including nearest
neighbor, linear, cubic, and cubic spline interpolations. The following
example provides a simple explanation of the interpolation process.
To determine the value of the pixel in the center of the following group:
RGR
GBG
RGR
When the pixels have the following values:
200 50 220
60 100 62
196 58 198
Neighboring pixels will be used to determine the RGB values for the
center pixel. The blue component will be taken directly from the pixel
value, and the green and red components are the average of the
surrounding green and red pixels, respectively.
R = (200 + 220 + 196 + 198)/4 = 203.5 ~ 204
G = (50 + 60 + 62 + 58)/4 = 57.5 ~ 58
B = 100
The final RGB value for the pixel is (204,58,100). This process will be
repeated for each pixel in the image.

White Level
The White Level defines the brightness of an image after white
balancing. The values for the red, green, and blue gains are determined
by dividing the white level by the mean value of each component color.
The maximum white level is 255. If the white level is too high or too low,
the image will appear too light or too dark. You can adjust the white level
to adjust image brightness.

NI-IMAQdx Devices
Complete the following steps to set the attributes of an NI-IMAQdx
device:
1. Specify a Video Mode for the camera from the Video Mode dropdown menu. This list is based on the video modes the camera
supports.
Note This option is only available for FireWire® cameras. A
GigE camera will display the current settings in this
pulldown, but users cannot edit the pulldown. You must use
the attributes in the tree to change the resolution or video
type.
2. Check the Show All Attributes check box to display all the
attributes, including acquisition attributes and status information.
3. Select the attribute to change from the attribute tree.
4. Set the value of the attribute using the Value control.
Note Use the Reset to Defaults to set all the attributes to
the default values configured in Measurement &
Automation Explorer (MAX).
5. Repeat steps 3-4 for all the attributes to change.
6. Click Next.

Simulated Acquisition
Use Simulated Acquisition to select a folder of image files, or an AVI to
simulate an acquisition.
Note NI Vision must installed in the location the Vision Acquisition
Express VI will run for the Simulated Acquisition feature to be
available.

Folder of Images
Complete the following steps to configure an acquisition with a folder of
image files:
1. Use the Image Path control to specify a path to the image to use
for a simulated acquisition.
2. If the Cycle Through Folder of Images option is checked, the
acquisition will acquire additional image files in the same folder as
the image file specified by image path.
Note This control is not available when the acquisition type
is Single Acquisition with Processing.
3. Click Next.

AVI Path
Complete the following steps to configure an acquisition with an AVI path:
1. Use the AVI Path control to specify a path to the AVI file to use for
a simulated acquisition.
Note This acquisition type is not available when acquiring
on remote targets.
2. Click Next.

Selecting Controls and Indicators
In the Select Controls/Indicators step of the NI Vision Acquisition Express
Wizard, specify the controls and indicators that will be available on the
Express VI when you exit the Wizard. The controls and indicators
displayed depend on the type of acquisition source you selected, the
acquisition type, and the acquisition settings. Some controls and
indicators are required and cannot be unchecked. When you are done
configuring everything, click Finish and the Express VI is created with
the settings that you configured. If you setup a continuous acquisition or
a finite acquisition, looping structures are created the first time the
Express VI is configured.
The controls and indicators available will vary based on your device and
acquisition settings. Controls and indicators can be required or optional.
Controls are also divided into Setup Settings and Acquire Settings
controls. Setup Settings controls are used to configure the acquisition.
Setup Settings controls are used during the first iteration of the
acquisition. Acquire Settings controls are used to acquire images.
Acquire Settings controls can be changed at any point during the
acquisition.

Controls and Indicators Based on Devices
Refer to the following sections for information on the controls and
indicators available with different devices:
NI 17xx Smart Cameras
Analog, Digital and Camera Link Devices
IEEE 1394 and GigE Devices
Simulated Acquisition

Controls/Indicators for NI 17xx Smart Cameras
In the Select Controls/Indicators step of the NI Vision Acquisition Express
Wizard, specify the controls and indicators that will be available on the
Express VI based on the type of device used.

Controls
If you are using an NI 17xx smart camera, the following controls may be
available based on your acquisition settings:
Control
Description
Stop (F) Stops the acquisition. This is a required control when
performing a continuous acquisition.
Number Specifies the number of internal buffers into which image
of Image data will be acquired. This is an optional Setup Settings
Buffers control that only applies the first time the VI is called.
Pulse
Allows you to set the desired duration of the first phase of the
Delay
signal in timebase units. This control is available when a
pulse is selected as a digital output. This is an optional Setup
Settings control that only applies the first time the VI is
called.
Pulse
Allows you to set the desired duration of the second phase of
Width
the signal in timebase units. This is an optional Setup
Settings control that only applies the first time the VI is
called.
Exposure Controls how long to expose the sensor in milliseconds. This
Time
is an optional Acquire Settings control that is applied every
(ms)
time the Express VI is called.
Gain
Controls the gain of the sensor. This is an optional Acquire
Settings control that is applied every time the Express VI is
called.
Current Controls the current level, in milliamps, that the Direct Drive
Level
lighting controller will output. This control is available if the
(mA)
option to use the camera's internal lighting is selected. This is
an optional Acquire Settings control that is applied every
time the Express VI is called.
Pass
The green LED located on the smart camera that can be
LED
switched on or off. This is an optional Acquire Settings
control that is applied every time the Express VI is called.
Fail LED The red LED located on the smart camera that be switched
on or off. This is an optional Acquire Settings control that is

applied every time the Express VI is called.
Drive
Signal

Allows you to select what signal to drive. This control is
available when a Drive Status Signal is selected as a digital
output. This is an optional Acquire Settings control that is
applied every time the Express VI is called.

Drive
Polarity

Allows you to select the polarity of the signal to drive. This
control is available when Drive Status Signal is selected as
a digital output. This is an optional Acquire Settings control
that is applied every time the Express VI is called.

Indicators
If you are using an NI 17xx smart camera, the following indicators may be
available based on your acquisition settings:
Indicator
Description
All Image
An array of images allocated by the VI that you can
Buffers Out dispose of when the images are no longer in use. This
indicator is available when Continuous Acquisition with
Acquire Every Image or Finite Acquisition with Inline
Processing is selected as the acquisition type. This is a
required indicator.
Stopped
This indicator is used to stop a continuous acquisition. It is
only available when you are doing a continuous
acquisition. This is a required indicator.
Image Out The reference to the acquired image. This is a required
indicator.
Image
0-based indicator of how many images have been
Number
acquired. This is an optional indicator.
Total
1-based indicator of the total number of images acquired
Images
since the beginning of the acquisition. This is an optional
Transferred indicator.
Lost Image Returns the total number of lost frames in a continuous
Count
acquisition. The value increments by 1 each time images
are lost. This is an optional indicator.
Frame Rate The rate of images acquired in frames per second. This is
an optional indicator.
Maximum
Returns the maximum amount of current, in milliamperes
Current
(mA), that can be sourced by the Direct Drive lighting
Level (mA) controller under the current configuration. Only available
when internal lighting controller is used. This is an
optional indicator.
Temperature Returns the temperature of the smart camera in degrees
Celsius (ºC). This is an optional indicator.
Encoder
Only applies when Use Encoder Settings is selected as
Count
a configuration setting. This is an optional indicator.

Note This indicator is only available for smart
cameras that support quadrature encoders.

Controls/Indicators for Analog, Digital, and
Camera Link Devices
In the Select Controls/Indicators step of the NI Vision Acquisition Express
Wizard, specify the controls and indicators that will be available on the
Express VI based on the type of device used.

Controls
If you are using an Analog, Digital or Camera Link device, the following
controls may be available based on your acquisition settings:
Control
Description
Stop (F) Stops the acquisition. This is a required control when
performing a continuous acquisition.
Number Specifies the number of internal buffers into which image data
of
will be acquired. This is an optional Setup Settings control
Image that only applies the first time the VI is called.
Buffers
Number Indicates the number of images acquired after the Stop
of Post Trigger occurs. This control is available when End of
Trigger Acquisition is selected as a trigger action. This is an optional
Buffers Setup Settings control that only applies the first time the VI is
called.
Pulse
Allows you to set the desired duration of the first phase of the
Delay
signal in timebase units. This control is available when a pulse
is selected as a digital output. This is an optional Setup
Settings control that only applies the first time the VI is called.
Pulse
Allows you to set the desired duration of the second phase of
Width
the signal in timebase units. This is an optional Setup
Settings control that only applies the first time the VI is called.
Bayer
Sets the Bayer decoder pattern used to decode the image.
Settings This control is available when Perform Bayer Decoding is
selected. The Pattern, Red Gain, Green Gain, and Blue Gain
can be adjusted. This is a Setup Settings control that only
applies the first time the VI is called.
Drive
Allows you to select what signal to drive. This control is
Signal available when a Drive Status Signal is selected as a digital
output. This is an optional Acquire Settings control that is
applied every time the Express VI is called.
Drive
Allows you to select the polarity of the signal to drive. This
Polarity control is available when Drive Status Signal is selected as a
digital output. This is an optional Acquire Settings control that
is applied every time the Express VI is called.

Indicators
If you are using an Analog, Digital or Camera Link device, the following
indicators may be available based on your acquisition settings:
Indicator
Description
All Image An array of images allocated by the VI that you can
Buffers Out dispose of when the images are no longer in use. This
indicator is available when Continuous Acquisition with
Acquire Every Image or Finite Acquisition with Inline
Processing is selected as the acquisition type. This is a
required indicator.
Stopped
This indicator is used to stop a continuous acquisition. It is
only available when you are doing a continuous
acquisition. This is a required indicator.
Image Out The reference to the acquired image. This is a required
indicator.
Image
0-based indicator of how many images have been
Number
acquired. This is an optional indicator.
Total
1-based indicator of the total number of images acquired
Images
since the beginning of the acquisition. This is an optional
Transferred indicator.
Lost Image Returns the total number of lost frames in a continuous
Count
acquisition. The value increments by 1 each time images
are lost. This is an optional indicator.
Frame Rate The rate of images acquired in frames per second. This is
an optional indicator.
Raw Bayer This indicator is available when Perform Bayer Decoding
Image Out is selected. This is an optional indicator.
Image
The number of lines acquired per image. This indicator is
Height
available when Trigger Height of Acquisition is selected
as a trigger action. This is an optional indicator.
Pre Trigger This indicator is available if Trigger End of Acquisition is
Images
selected as a trigger action. This is an optional indicator.
Post
This indicator is available if Trigger End of Acquisition is
Trigger
selected as a trigger action. This is an optional indicator.

Images
Encoder
Count

Only applies when Use Encoder Settings is selected as a
configuration setting. This is an optional indicator.
Note This indicator is only available for frame
grabbers that support quadrature encoders that can
be read.

Controls/Indicators for an IEEE 1394 and GigE
Devices
In the Select Controls/Indicators step of the NI Vision Acquisition Express
Wizard, specify the controls and indicators that will be available on the
Express VI based on the type of device used.
Note Refer to the documentation provided by your camera
manufacturer for information on specific controls and indicators
available with your camera.

Controls
If you are using a IEEE 1394 or GigE device, the following controls may
be available based on your acquisition settings:
Control
Description
Stop (F) Stops the acquisition. This is a required control when
performing a continuous acquisition.
Number Specifies the number of internal buffers into which image data
of Image will be acquired. This is an optional Setup Settings control
Buffers that only applies the first time the VI is called.

Indicators
If you are using an IEEE 1394 or GigE device, the following indicators
may be available based on your acquisition settings:
Indicator
Description
All Image An array of images allocated by the VI that you can
Buffers Out dispose of when the images are no longer in use. This
indicator is available when Continuous Acquisition with
Acquire Every Image or Finite Acquisition with Inline
Processing is selected as the acquisition type. This is a
required indicator.
Stopped
This indicator is used to stop a continuous acquisition. It is
only available when you are doing a continuous
acquisition. This is a required indicator.
Image Out The reference to the image. This is a required indicator.
Image
0-based indicator of how many images have been
Number
acquired. This is an optional indicator.
Total
1-based indicator of the total number of images acquired
Images
since the beginning of the acquisition. This is an optional
Transferred indicator.
Lost Image Returns the total number of lost frames in a continuous
Count
acquisition. The value increments by 1 each time images
are lost. This is an optional indicator.
Lost
Returns the number of lost packets during an acquisition
Packet
session. This is an optional indicator.
Count
Note This indicator is only available for GigE
cameras.
Requested Returns the number of packets requested to be resent
Resend
during an acquisition session. This is an optional indicator.
Packet
Note This indicator is only available for GigE
Count
cameras.
Received
Resend
Packets

Returns the number of packets that were requested to be
resent during an acquisition session and were completed.
This is an optional indicator.

Note This indicator is only available for GigE
cameras.

Controls/Indicators for Simulated Acquisition
In the Select Controls/Indicators step of the NI Vision Acquisition Express
Wizard, specify the controls and indicators that will be available on the
Express VI based on the type of device used.

Controls
If you are performing a Simulated Acquisition, the following controls may
be available based on your acquisition settings:
Control
Description
Stop (F) Stops the acquisition. This is a required control when
performing a continuous acquisition.
AVI Path The filepath for the AVI file to read. This control is only
available if you select AVI as the simulated acquisition source.
This is a Setup Settings control that only applies the first time
the VI is called.
Image
The complete filepath for the image file. This control is only
Path
available if you select Folder of Images as the simulated
acquisition source. This is a Setup Settings control that only
applies the first time the VI is called.
Cycle
Cycles through a folder of images. This is a Setup Settings
Through control that only applies the first time the VI is called and when
Folder a folder of images is the acquisition source.
Number Specifies the number of internal buffers into which image data
of
will be acquired. This is a Setup Settings control that is only
Image
available the first time the VI is called.
Buffers

Indicators
If you are performing a Simulated Acquisition, the following indicators
may be available based on your acquisition settings:
Indicator
Description
All Image An array of images allocated by the VI that you can
Buffers Out dispose of when the images are no longer in use. This
indicator is available when Continuous Acquisition with
Acquire Every Image or Finite Acquisition with Inline
Processing is selected as the acquisition type. This is a
required indicator.
Stopped
This indicator is used to stop a continuous acquisition. It is
only available when you are doing a continuous
acquisition. This is a required indicator.
Image Out The reference to the acquired image. This is a required
indicator.
Image
0-based indicator of how many images have been
Number
acquired. This is an optional indicator.
Total
1-based indicator of the total number of images acquired
Images
since the beginning of the acquisition. This is an optional
Transferred indicator.
Lost Image Returns the total number of lost frames in a continuous
Count
acquisition. The value increments by 1 each time images
are lost. This is an optional indicator.
Frame Rate The rate of images acquired in frames per second. This is
an optional indicator.
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A
array

Ordered, indexed set of data elements of the same
type.

aspect ratio

The ratio of a picture or image's width to its height.

asynchronous (1) Independent in time from any other event. (2)
Communication mechanism on the IEEE 1394 bus,
which guarantees delivery of the message but does not
guarantee timing.

B
Bayer
Method to produce color images with a single imaging
encoding sensor, as opposed to three individual sensors for the red,
green, and blue components of light.
Bayer
pattern

Color filter array pattern that can appear in four variations,
depending on the current left and top offsets of the
acquisition window:
GBGB GRGR BGBG RGRG
RGRG BGBG GRGR GBGB

buffer

Temporary storage for acquired data.

D
default A default parameter value recorded in the driver; in many
setting cases, the default input of a control is a certain value (often 0)
that means use the current default setting.

E
external
trigger

A voltage pulse from an external source that triggers an
event such as A/D conversion.

F
frame A complete image; in interlaced formats, a frame is composed of
two fields.

G
gain

Applied value to compensate for discrepancies in the filter for
a particular color.

Gigabit Describes technologies which transmit Ethernet packets at a
Ethernet rate of a gigabit per second.
GigE
Vision

A camera interface standard developed using the Gigabit
Ethernet communication protocol.

grab

Performs an acquisition that loops continually on one buffer.
You obtain a copy of the acquisition buffer by grabbing a copy
to a separate buffer that can be used for analysis.

GUI

Graphical user interface. An intuitive, easy-to-use means of
communicating information to and from a computer program
by means of graphical screen displays; GUIs can resemble
the front panels of instruments or other objects associated
with a computer program.

I
I/O

Input/output. The transfer of data to/from a computer system
involving communications channels, operator interface
devices, or data acquisition and control interfaces.

IEEE

Institute of Electrical and Electronics Engineers.

ISO
A high voltage isolated trigger.
Trigger

L
LUT Lookup table. A selection in Measurement & Automation Explorer
(MAX) for Vision that contains formulas that let you implement
simple imaging operations such as contrast enhancement, data
inversion, gamma manipulation, or other nonlinear transfer
functions.

M
MAX

Measurement & Automation Explorer. The National
Instruments Windows-based graphical configuration utility you
can use to configure NI software and hardware, execute
system diagnostics, add new channels and interfaces, and
view the devices and instruments you have connected to your
computer. MAX is installed on the desktop during the National
Instruments driver software installation.

memory See buffer.
buffer
memory Continuous blocks of memory that can be accessed quickly
window by changing addresses on the local processor.

N
NIIMAQ

Driver software for National Instruments image acquisition
hardware.

NINational Instruments driver software for IEEE 1394 and GigE
IMAQdx Vision cameras.

O
one- Applies to pulse generation and acquisitions. A one-shot pulse
shot or acquisition happens only once.

P
PCI

Peripheral Component Interconnect. A high-performance
expansion bus architecture originally developed by Intel to
replace ISA and EISA; it is achieving widespread acceptance
as a standard for PCs and workstations and offers a theoretical
maximum transfer rate of 133 Mbytes/s.

PCIe

PCI Express. A high-performance expansion bus architecture
originally developed by Intel to replace PCI. PCIe offers a
theoretical maximum transfer rate that is dependent upon lane
width. A x1 link theoretically provides 250 MB/s in each
direction—to and from the device. Once overhead is accounted
for, a x1 link can provide approximately 200 MB/s of input
capability and 200 MB/s of output capability. Increasing the
number of lanes in a link increases maximum throughput by
approximately the same factor.

PCLK Pixel clock signal. Times the sampling of pixels on a video line.
pixel

Picture element. The smallest division that makes up the video
scan line; for display on a computer monitor, a pixel's optimum
dimension is square (aspect ratio of 1:1, or the width equal to
the height).

pixel The ratio between the physical horizontal size and the vertical
aspect size of the region covered by the pixel. An acquired pixel
ratio should optimally be square, thus the optimal value is 1.0;
however, typically it falls between 0.95 and 1.05, depending on
camera quality.
pixel
clock

Divides the incoming horizontal video line into pixels.

pixel The total number of pixels between two horizontal sync signals;
count the pixel count determines the frequency of the pixel clock.

Q
quadrature An encoding technique for a rotating device where two
encoder
tracks of information are placed on the device, with the
signals on the tracks offset by 90 degrees from each other.
The phase difference indicates the position and direction of
rotation.

R
real time A property of an event or system in which data is processed
as it is acquired instead of being accumulated and
processed at a later time.
resolution The smallest signal increment that can be detected by a
measurement system; resolution can be expressed in bits,
in proportions, or in percent of full scale. For example, a
system has 12-bit resolution, one part in 4,096 resolution,
and 0.0244 percent of full scale.
RGB

Red, green, and blue. The three primary colors used to
represent a color picture. An RGB camera is a camera that
delivers three signals, one for each primary.

ring

Performs an acquisition that loops continually on a specified
number of buffers.

ROI

Region of interest. (1) An area of the image that is
graphically selected from a window displaying the image.
This area can be used focus further processing; (2) A
hardware-programmable rectangular portion of the
acquisition window.

RTSI bus Real-Time System Integration Bus. The National
Instruments timing bus that connects image acquisition and
DAQ devices directly, by means of connectors on top of the
devices, for precise synchronization of functions.

S
saturation The richness of a color. A saturation of zero corresponds to
no color, that is, a gray pixel. Pink is a red with low
saturation.
sequence Performs an acquisition that acquires a specified number of
buffers, then stops.
snap

Acquires a single frame or field to a buffer.

sync

Tells the display where to put a video picture; the horizontal
sync indicates the picture's left-to-right placement and the
vertical sync indicates top-to-bottom placement.

T
timeout

Length of time, in milliseconds, that the driver waits for an
image from the camera before returning an error

transfer
rate

The rate, measured in bytes/s, at which data is moved
from source to destination after software initialization and
setup operations; the maximum rate at which the hardware
can operate.

trigger

Any event that causes or starts some form of data capture.

trigger
control
and
mapping
circuitry

Circuitry that routes, monitors, and drives the external and
RTSI bus trigger lines; you can configure each of these
lines to start or stop acquisition on a rising or falling edge.

TTL

Transistor-transistor logic. A digital circuit composed of
bipolar transistors wired in a certain manner. A typical
medium-speed digital technology. Nominal TTL logic levels
are 0 and 5 V.

U
user Memory buffer created by the user as a destination for the
buffer image. In LabVIEW, this is created with the IMAQ Create VI.

V
VI Virtual Instrument.
1. A combination of hardware and/or software elements,
typically used with a PC, that has the functionality of a
classic stand-alone instrument
2. A LabVIEW software module (VI), which consists of a front
panel user interface and a block diagram program.
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Pulse Examples
There are three types of Pulses available for the Type setting:
Pulse Train will start generating a continuous pulse train when the
pulse trigger occurs, as shown in the following figure:

Single Pulse generates a pulse on the first assertion edge of the
selected pulse trigger, as shown in the following figure.

Rearmed Pulse generates a pulse on all assertion edges of the
selected pulse trigger, as shown in the following figure.

Branch Offices
Office
Australia

Telephone Number
1800 300 800

Austria
Belgium
Brazil
Canada

43 662 457990-0
32 (0) 2 757 0020
55 11 3262 3599
800 433 3488

China
Czech Republic
Denmark
Finland
France
Germany
India
Israel
Italy
Japan
Korea
Lebanon
Malaysia
Mexico
Netherlands
New Zealand
Norway
Poland
Portugal
Russia
Singapore
Slovenia

86 21 5050 9800
420 224 235 774
45 45 76 26 00
358 (0) 9 725 72511
33 (0) 1 57 66 24 24
49 89 7413130
91 80 41190000
972 0 3 6393737
39 02 41309277
0120-527196 / 81 3 5472 2970
82 02 3451 3400
961 (0) 1 33 28 28
1800 887710
01 800 010 0793
31 (0) 348 433 466
0800 553 322
47 (0) 66 90 76 60
48 22 3390150
351 210 311 210
7 495 783 6851
1800 226 5886
386 3 425 42 00

South Africa

27 0 11 805 8197

Spain
Sweden
Switzerland
Taiwan

34 91 640 0085
46 (0) 8 587 895 00
41 56 2005151
886 02 2377 2222

Thailand
Turkey
United Kingdom
United States (Corporate)

662 278 6777
90 212 279 3031
44 (0) 1635 523545
512 683 0100

